Configuracién del registro de eventos seguro de
NetFlow en Firepower Threat Defence
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Introduccion

Este documento describe como configurar NetFlow Secure Event Logging (NSEL) en Firepower
Threat Defense (FTD) a través de Firepower Management Center (FMC).

Prerequisites

Requirements
Cisco recomienda que tenga conocimiento sobre estos temas:

. Conocimiento del CSP
. Conocimiento de FTD
- Conocimiento de la politica FlexConfig

Componentes Utilizados

La informacion que contiene este documento se basa en las siguientes versiones de software y
hardware.

- FTD version 6.6.1

- FMC version 6.6.1
La informacion que contiene este documento se cred a partir de los dispositivos en un ambiente
de laboratorio especifico. Todos los dispositivos que se utilizan en este documento se pusieron en
funcionamiento con una configuracion verificada (predeterminada). Si tiene una red en vivo,
asegurese de entender el posible impacto de cualquier comando.

Antecedentes

Este documento describe como configurar NetFlow Secure Event Logging (NSEL) en Firepower
Threat Defense (FTD) a través de Firepower Management Center (FMC).



Los objetos de texto FlexConfig estan asociados a variables utilizadas en los objetos FlexConfig
predefinidos. Los objetos FlexConfig predefinidos y los objetos de texto asociados se encuentran
en FMC para configurar NSEL. Hay cuatro objetos FlexConfig predefinidos en el FMC y tres
objetos de texto predefinidos. Los objetos FlexConfig predefinidos son de solo lectura y no se
pueden modificar. Para modificar los parametros de NetFlow, se pueden copiar los objetos.

En la tabla se enumeran los cuatro objetos predefinidos:

FlexConfig Object Name Description

Netflow Add Destination Creates and configures a NetFlow export destination
Netflow_Set Parameters Sets globla parameters for NetFlow export
Netflow_Delete_Destinations Deletes a NetFlow export destination

Netwflow Clear Parameters Restores Netflow export global default settings

En la tabla se enumeran los tres objetos de texto predefinidos:

Text Object Name Description

Define the single NetFlow export destination’s interface, destination IP

netflow_Destination
address and UDP port number for NetFlow.

netwflow_Event_Types Define NetFlow events based on event type

Define values for active refresh-interval, delay flow-create and template

netflow_Parameters :
timeout-rate.

Configurar

En esta seccidn se describe como configurar NSEL en FMC mediante una politica FlexConfig.
Paso 1. Establezca los parametros de los objetos de texto para Netflow.

Para establecer los parametros de variable, navegue hasta Objetos > FlexConfig > Objetos de
texto. Edite el objeto netflow_Destination. Defina el tipo de variable multiple y el recuento

establecido en 3. Establezca el nombre de la interfaz, la direccion IP de destino y el puerto.

En este ejemplo de configuracion, la interfaz es DMZ, la direccion IP del colector de NetFlow es
10.20.20.1 y el puerto UDP es 2055.



Edit Text Object @

Name:
Description:
Variable Type Count
Multiple 3 =
1 DMZ

2 10.20.20.1
3 2055

Nota: Se utilizan los valores predeterminados para netflow_Event_Types y
netflow_Parameters.

Paso 2. Configure un objeto de lista de acceso ampliado para que coincida con el trafico
especifico.

Para crear una lista de acceso ampliada en FMC, navegue hasta Objetos > Gestion de objetos y
en el menu de la izquierda, debajo de Lista de acceso seleccionar Ampliado.Haga clic en Agregar
lista de acceso ampliada.

Rellene el campo Nombre. En este ejemplo, el nombre es flow_export_acl. ‘Haga clic en el botdn
Add (Agregar).’ Configure las entradas de control de acceso para que coincidan con el trafico
especifico.

En este ejemplo, se excluye el trafico del host 10.10.10.1 a cualquier destino y el trafico entre el
host 172.16.0.20 y 192.168.1.20. Se incluye cualquier otro trafico.



Edit Extended Access List Object

Name

| ow_export_ac!

Entries (3)

Sequence Action

1 @Elock
2 QEBlock

3 SAllow
Allow Overrides

Source

10.10.10.1
172.16.0.20

Any

Source Port

Any
Any

Any

Paso 3. Configure un objeto FlexConfig.

Destination

Any
192.168.1.20

Any

Destination Port

Any
Any

Any

Para configurar los objetos de FlexConfig, navegue hasta Objetos > FlexConfig > Objetos de

FlexConfig y haga clic en el botén Agregar objeto de FlexConfig.

Defina el mapa de clase que identifica el trafico para el que se deben exportar los eventos de

NetFlow. En este ejemplo, el nombre del objeto es flow_export_class.

Seleccione la lista de acceso creada en el paso 2. Haga clic en Insert > Insert Policy Object >
Extended ACL Object y asigne un nombre. A continuacion, haga clic en el boton Add. En este

ejemplo, el nombre de la variable es flow_export_acl. Click Save.



Insert Extended Access List Object Variable ®

Variable Name:

[ flow_export_acl ‘

Description:
Available Objects C' Selected Object
‘ Q Search X ‘ flow_export_acl v

flow_export_acl

Agregue las siguientes lineas de configuracion en el campo en blanco a la derecha e incluya la
variable previamente definida ($flow_export_acl.) en la linea de configuracién de match access-
list.

Observe que un $ simbolo comienza el nombre de la variable. Esto ayuda a definir que una
variable viene después de ella.

class-map fl ow export_cl ass
mat ch access-list $flow export_acl

Haga clic en Guardar cuando haya terminado.




Edit FlexConfig Object @
Name:
flow_export_class

Description:

A Copy-pasting any rich text might introduce line breaks while generating CLI. Please verify the CLI before deployment.
Insert - Deployment: Everytime Type: Append

class-map flow export class
match access-list Sflow export acl|

¥ Variables
Name Dimension Default Value Property ) Override Description
(Type:Name)
low_export_class SINGLE low_export_acl EXD_ACL:A...

Paso 4. Configuracion del destino de Netflow

Para configurar el destino de Netflow, navegue hasta Objetos > FlexConfig > Objetos de
FlexConfig y filtre por Netflow. Copie el objeto Netflow_Add_Destination. Se crea
Netflow_Add_Destination_Copy.

Asigne la clase creada en el paso 3. Puede crear un nuevo policy map para aplicar las acciones
de exportacién de flujo a las clases definidas.

En este ejemplo, la clase se inserta en la directiva actual (directiva global).

## destination: interface_naneif destination_ip udp_port

## event-types: any subset of {all, flowcreate, flowdenied, flowteardown, flow update}

flow

export destination $netflow Destination.get(0) $netflow Destination.get(1l) $netflow Destination.
get (2)

policy-map gl obal _policy
cl ass flow export_class
#f oreach ( $event _type in $netflow Event _Types )
fl ow export event-type $event _type destinati on $netflow Destination.get(1)
#end

Haga clic en Guardar cuando haya terminado.



Edit FlexConfig Object (1]

Name:

| Netflow_Add Destination_Copy

Description:

Create and configure a NetFlow
export destination.

A Copy-pasting any rich text might introduce line breaks while generating CLI. Please verify the CL| before deployment.
Insert » Deployment: Once v | Type: | Append v

f## destination: interface nameif destination ip udp port
#4 event-types: any subset of {all, flow-create, flow-denied, flow-teardown, flow-update}
flow-
export destination Spetflow Destination.get (0) Snetflow Destination.get(l) Snetflow Destination.get(2)
policy-map global policy
class flow export class
#foreach (_$eventitype in $netflow Event Types )
flow-export event-type $event type destination $S$netflow Destination.get (1)

#end
v Variables
Name Dimension Default Value r;s:z:ime] Override Description
netflow_Event_Types MULTIPLE [all] FREEFORM: false This variable provides the glo...
netflow_Destination MULTIPLE [DMZ, 10.20.20.... FREEFORM:... false This variable defines a single ...

Paso 5. Asignar la politica FlexConfig al FTD

Navegue hasta Devices > FlexConfig y cree una nueva politica (a menos que ya haya una creada
para otro propésito y asignada al mismo FTD). En este ejemplo, ya se ha creado FlexConfig.
Edite la politica FlexConfig y seleccione los objetos FlexConfig creados en los pasos anteriores.

En este ejemplo, se utilizan los parametros de exportacion de Netflow predeterminados, por lo
tanto, se selecciona Netflow_Set_Parameters. Guarde los cambios e impleméntelo.



FlexConfigPolicy

Enter Description

“a Selected Prepend FlexConfigs
Available FlexConfig C FlexCanfig Object

netflow X

L] Mame

~ User Defined
"B Netflow_Add_
7 Metfiow_Delete_Destination_Copy
of Matflow_export_Copy
"8 Metfow_Set_Parameters_Copy
* Systam Dafined
"B Metfiow_Add_Destination =7 Selected Append FlexConfigs
«f Netfiow_Clear_Parameters " Marme
o5 Netflow_Delete_Destination

| etovsormrees [

2 Netflow_Add_Destination_Copy

flow_gxpon_class

3 Netlow_Sel_Parameters

You have unsaved changes [

Description

Dascription

Create and configure a MetFlow export destination.

Set global parameters for NetFlow export,

Palicy Assignments (1)

Nota: Para hacer coincidir todo el trafico sin necesidad de hacer coincidir trafico especifico,

puede saltar de los pasos 2 a 4 y utilizar los objetos NetFlow predefinidos.

FlexConfigPolicy

Enter Description

"% Selected Prepend FlexConfigs
Avallable FlexConfig C  [IREEEEEE RS

netflow X

L MName

* User Defined
"8 Netflow_Add_Destination_Copy
=7 Netflow_Delete_Destination_Cogpy
 Netflow_export_Copy
"8 Metfiow_Set_Parameters_Copy

" System Defined

«ff Metflow_Clear_Parameters

<7 Selected Append FlexConfigs

L Mame
o Metflow_Delete_Destination

- 1

Netflow_Set_Parameters
% Netf

2 Netflow_add_Destination

You have unsaved changes | Preview Config Cancel

Description

Description

Set global parameters for NetFlow expart.

Create and confgure a NetFlow export destination.

Policy Assignments (1)

Nota: Para agregar un segundo colector NSEL al que se envian los paquetes de NetFlow.
En el paso 1, agregue 4 variables para agregar la segunda direccién IP del recopilador de

Netflow.



Edit Text Object @

Name:

Description:

Variable Type Count
Multiple 4 3

—

DMZ
10.20.20.1
2055

AW N

10.20.20.1

En el paso 4, agregue la linea de configuracién: flow-export destination
$netflow_Destination.get(0) $netflow_Destination.get(1) $netflow_Destination.get(2)

Edite la variable $netflow_Destination.get para la variable de correspondencia. En este ejemplo, el
valor de la variable es 3. Por ejemplo:

flow
export destination $netflow Destination.get(0) $netflow Destination.get(1l) $netflow Destination.

get (2)
flow
export destination $netfl ow Destination.get(0) $netflow Destination.get(3) $netflow Destination.

get (2)
Ademas, agregue la segunda variable $netflow_Destination.get en la linea de configuracion: flow-
export event-type $event_type destination $netflow_Destination.get(1). Por ejemplo:

fl ow export event-
type $event _type destination $netflow Destination.get(1l) $netflow Destination.get(3)

Valide esta configuracién tal como se ve en la siguiente imagen:



Edit FlexConfig Object

Name:
Netflow_Add_Destination_Copy |

Description:

Create and configure a NetFlow
export destination.

A Copy-pasting any rich text might introduce line breaks while generating CLI. Please verify the CLI before deployment.

‘ Insert » ‘ Deployment: | Once v | Type: | Append v

## event-types: any subset of {all, flow-create, flow-denied, flow-teardown, flow-update}
flow-

#4 destination: interface nameif destination ip udp port

policy-map global policy
class flow export class
fiforeach ( Sevent_type in $Snetflow_Event Types )
flow-export event-

fend
¥ Variables
Name Dimension Default Value {Ffrry?:sirl':ime] Override Description
netflow_Event_Types MULTIPLE [all] FREEFORM:... false This variable provides the glo...
netflow_Destination MULTIPLE [DMZ, 10.20.20.... FREEFORM:... false This variable defines a single ...

Cancel

Verificacion

La configuracién de NetFlow se puede verificar dentro de la politica FlexConfig. Para obtener una
vista previa de la configuracion, haga clic en Preview Config. Seleccione el FTD y verifique la

configuracion.



Preview FlexConfig @

Select Device:
FTD-b

exit
INTERFACE_END

H#HitHFlex-config Appended CLI #H#
class-map flow_export_class
match access-list flow_export_acl

flow-export destination DMZ 10.20.20.1 2055
policy-map global_policy
class flow_export_class
flow-export event-type all destination 10.20.20.1

flow-export active refresh-interval 1
no flow-export delay flow-create 1
flow-export template timeout-rate 30

Close

Acceda al FTD a través de Secure Shell (SSH) y utilice el comando system support diagnostic-cli
y ejecute estos comandos:

> system support diagnostic-cli
Attaching to Diagnostic CLI ... Press '"Crl+a then d to detach.
Type help or '?' for a list of avail abl e commands.

firepower# show access-1ist flow export_acl

access-list flow export_acl; 3 elenents; name hash: Oxe30f ladf

access-list flow export_acl line 1 extended deny object-group ProxySG Ext endedACL_34359742097
obj ect 10.10.10.1 any (hitcnt=0) 0Ox8edff419

access-list flow export_acl line 1 extended deny ip host 10.10.10.1 any (hitcnt=0) 0x3d4f23a4
access-list flow export_acl line 2 extended deny object-group ProxySG Ext endedACL_34359742101
obj ect 172.16.0.20 object 192.168.1.20 (hitcnt=0) OxOec22ecf

access-list flow export_acl line 2 extended deny ip host 172.16.0.20 host 192.168.1.20
(hitcnt=0) 0Ox134aaeea

access-list flow export_acl line 3 extended pernmit object-group ProxySG Ext endedACL_30064776111
any any (hitcnt=0) 0x3726277e

access-list flow export_acl line 3 extended pernit ip any any (hitcnt=0) O0x759f5ecf

firepower# sh running-config class-map fl ow _export_cl ass
class-map fl ow export_cl ass
mat ch access-list flow export_acl

firepower# show runni ng-config policy-map
1

policy-map type inspect dns preset_dns_map
paraneters

message- | ength maxi mum client auto
message- | engt h maxi mum 512

no tcp-inspection




policy-map type inspect ip-options UM STATI C | P_OPTI ONS_MAP
paraneters

eool action allow

nop action allow

router-alert action allow

policy-map gl obal policy

cl ass inspection_default

nspect dns preset_dns_map

nspect ftp

nspect h323 h225

nspect h323 ras

nspect rsh

nspect rtsp

nspect sql net

nspect skinny

nspect sunrpc

nspect xdntp

nspect sip

nspect netbi os

nspect tftp

nspect icnp

nspect icnp error

nspect i p-options UM STATI C_| P_OPTI ONS_MAP
nspect snnp

cl ass fl ow export_cl ass

fl ow export event-type all destination 10.20.20.1
class cl ass-default

set connection advanced-options UM STATI C_TCP_NAP

firepower# show running-config | include flow

access-1ist flow export_acl extended deny object-group ProxySG Ext endedACL_34359742097 obj ect
10. 10.10.1 any

access-1ist flow export_acl extended deny object-group ProxySG Ext endedACL_34359742101 obj ect
172.16. 0. 20 object 192.168.1.20

access-1ist flow export_acl extended pernit object-group ProxySG Ext endedACL_30064776111 any any
fl ow export destination DVZ 10.20.20.1 2055

class-map fl ow _export_cl ass

mat ch access-list flow export_acl

class fl ow export_cl ass

fl ow export event-type all destination 10.20.20.1
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. Asistencia técnica y descargas de Cisco




Acerca de esta traduccidén

Cisco ha traducido este documento combinando la traduccién automatica y los recursos
humanos a fin de ofrecer a nuestros usuarios en todo el mundo contenido en su propio
idioma.

Tenga en cuenta que incluso la mejor traduccién automatica podria no ser tan precisa como
la proporcionada por un traductor profesional.

Cisco Systems, Inc. no asume ninguna responsabilidad por la precision de estas
traducciones y recomienda remitirse siempre al documento original escrito en inglés (insertar
vinculo URL).



